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Directions how to use 
EM38 meter 

with ArcGIS and GPS 



Setup Diagram 
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Check list for EM 38 meter 
 
This is a sample checklist to use before going to the field 
with the EM38 and other components. You should create 
your own checklist based on components you use. 
 
 
 

� GPS backpack 
� GPS battery (car charger) 
� GPS hand device 
� GPS backpack fuses 
� Extra battery AA for GPS hand device  
� 2 blue device (Bluetooth connections)  
� Tablet 
� PC card 
� Extra battery for tablet  
� 9 volts battery for EM meter 
� EM meter 
� EM meter cord (for PC card & EM meter connection) 
� Field equipment (auger, color book, transect sheet, soil survey, etc.) 



DISPLAY 

How to Set Up and Calibrate the EM Device 
 

Turn on the device 
Check the battery by turning the knob to “BATT” 

Make sure that the number is less than ‐700 (i.e.: ‐946), if 
it is more than ‐700 – change the battery 

Switch to “ON” 
IMPORTANT!!!!! ‐ Remove all jewelry from hands, neck, and pockets. 

Let the device warm up for 5‐15 minutes before use. 
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Step 1 
 
 
 
 
 
Step 2 
 
 
 
 
Step 3 
 
 
 
 
Step 4 
 
 
Step 5 

Calibrating 
 
Place EM38 on the ground – the black bar along the bottom 
touching the ground 
Flip switch to Q/P 
Notice the reading, “Zero” it out using the Q/P knob 
 
Flip switch to I/P 
Notice the reading changed, “Zero” it out using the I/P knobs 

(Coarse and Fine Controls) 
 
Flip switch back to Q/P 

Make sure that it still reads zero 
If not, “Zero” it out using the Q/P knob 

 
Look at the current position of the I/P Coarse Control Knob and 
make a mental note 

I/P ZERO 
 
 

COARSE 

PHASE 

 
ZERO 

 

Q/P 

MODE 
 

Q/P I/P 

 

 
 
 
 
 
 
 
 
Step 6 
 
 
 
 
Step 7 
 
 
Step 8 

Move the I/P Coarse Control Knob one step clockwise – there 
shouldn’t be a change in the reading 

If there is a change – move the Phase Control until the 
one‐step move on the I/P Coarse Control Knob from 
where it was at Step 4 doesn’t change—to move the 
Phase Control Knob, loosen the nut first and tighten when 
done 

 
Lift the EM38 to about 5 feet above the ground. The black bar 
along the bottom of the meter should be pointing out to the 
horizon 
 
Reset meter as you did in Steps 1‐3 with the meter still pointed to 
the horizon 
 
Make sure the Mode is still in Q/P. 
Adjust the Q/P knob to read a value (it doesn’t matter which one), 
remember it. 
Keep the device in the air, at the same height and rotate it to 
where the black bar along the bottom is pointed towards the 
ground. 
Note the reading. 
Subtract the two readings and remember the difference for the 
next step. 



Step 9  
With device still lifted, return to position as in Step 6 – out to the horizon – using 
the Q/P zero control change the reading to the difference found in Step 8. 

 
Step 10 

At the same height rotate device so black bar is facing the ground and the 
reading should be double. 

 
 

Step 11 
 Make sure you are connected to the computer and start walking! 



 

 
 

Set up the EM meter with ArcGIS and GPS 
 
 
 

I. Set the computer 
• Go to the Bluetooth icon on your taskbar 
• Click on create a new connection (for each device) 
• Next 
• Click on custom mode 
• Next 
• Select a device: 

1.   0028 
2.   0051 

• Next 
• Next 
• Uncheck the box for default COM 
• Select COM for a device 

• COM: 4 ----- Assign to device 028 
• COM: 9 ----- Assign to device 051 

• Next 
• Finish 
• Right click or double click on the device Bluetooth to make a connection 

 
 

Repeat steps for 2nd device 
 
 
 
 

II. Set the programs 
 

1.   ArcGIS 
• View 
• Toolbars 
• Turn on GPS toolbar 
• On GPS toolbar dropdown menu 

1.   Click on connection set up (if error open & close the GPS 
Connection) 

• Check communication set up for COM: 4 
• Ok 

• On GPS toolbar click on open connection icon 
• On GPS toolbar go to dropdown menu and click on GPS position 

window 
 

   Change from point to trail to make a line file 



• On GPS toolbar dropdown menu click on Display Options 
• Click on trail tab 
• Go to linear trail 
• Check on box (show trail as a line) 
• Ok 

 
♦ Blue light on Device 028 (GPS back pack) should be on. Indicate a Bluetooth 
communication. 

 
 
 

2.   A.  EM 38 
 

   Before opening the EM 38 program you should calibrate then connect 
the PC card to the EM device. 

 
• Click on system Set Up tab 
• Check EM 38 is on COM: 5 (always) 
• GPS port on COM: 9 
• Ok 
• Click on Login tab 
• Save the file 
• Name the file 
• Click save (automatically save on C drive) 
• Click “Go” 



  

How to convert raw data to processed data in DAT38W 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Open DAT38W program 
 On toolbar click Convert EM38pro Files tab 



  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 On drop down menu click on Convert Files 
 Select Convert EM38pro Files to DAT38 (G38) Format 

 Input file (raw data: ex. 060114A.R38), select from window 
 Output file (enter same # 060114A without extension) 

 Click Convert button (process data will have .G38 extension) 
 Exit 



  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 On toolbar click GPS Positioning tab and select GPS Positioning 



 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 For Input select the process data (the output file from previous step (.G38)) 
 For Output convert the .G38 file to .XYZ file. Use same file name without 
extension. 
 For Select data click Conductivity/Vertical 
 For Output File Format click Generic 
 For Geodetic System click DD.DDDD 
 Un check GPS Correction box 
 Click Apply 
 Exit 
 Close DAT38W program 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

Importing data to Microsoft Excel 
 

 Open Excel 
 On toolbar select Data 
 On sub menu select From Text which opens a file navigation pane 
 Make sure it is set to select from All Files 
 Navigate to and select your .XYZ file  
 Click Import button 
 Select Delimited, click Next  
 Select Tab, Comma, and Space, click next 
 Click Finish 
 Excel sheet will be populated 
 Delete Time and Format column 
 Rename East column with X, rename North column with Y, leave QV1 the same 
 Save file as CSV(comma delimited) with same name or numbers 
 Close Excel program 

 
  



 
 

 

 

 

 

Example Procedure for Creating and Displaying EMI Survey Data in 
ArcGIS 
 

 

In ArcMap, click “Add Data” button and navigate to desired .txt, .csv,  or .xlsx file. 

 

 

 

 

 

 

 

 



 
 

Right-click on the .txt file (#1) of interest in the table of content. Select “Display XY Data.” 

 

The next step is to set your X and Y fields to correspond with your data and set your coordinate system in your 
“Display XY Data Menu.” Make sure that your X Field is “Easting” and your Y Field is “Northing.” Then select the 
“edit” button. This will initiate the “Spatial Reference Properties” window. Here, click the “Select” button to choose 
the appropriate UTM zone under “projected coordinate system.” 

 

 

#1 



 
 

Once you apply the above settings, the data will be displayed as shown below. 

 

The data points displayed need to be converted to a shapefile. Right-click on the point file in the “Table of 
Contents” and select Data Export Data…to convert to shapefile. 

 

 



 
 

Using the folder icon, navigate to the directory folder of your choosing and rename the new shapefile. In the “Saving 
Data” dialog box, make sure that the “Save as type:” is Shapefile. Add the new shapefile to your project, and remove 
the .txt file. 

 

Next, open ArcToolbox and navigate to the Kriging or IDW Tool located within the “Spatial Analyst Tools” 
under Interpolation (try both and compare how they affect interpretations). 

 



 
 

When the Kriging dialog box opens, select the shapefile you exported and set the “Z value field” to reflect 
the EC data you want to display. Also, you can rename and select the location to store the output surface 
raster created in this step. Normally, we utilize the default parameters for the other settings. Adjust those 
as you see fit. 

 

 

If the interpolation runs correctly, the following should display. 

 



 
 

You will want to clip the area of the previous raster that extends beyond the EMI survey area to avoid 
extrapolation into areas that are not surveyed with the equipment. To do this, open ArcCatalog and 
create a Personal Geodatabase, which will in turn create a boundary shapefile contained within a feature 
dataset. Navigate to the location where you want to create and save your Personal Geodatabase. Right-
click and select NewPersonal Geodatabase. Rename the database to your liking.  

 

 

Double-click on the Personal Geodatabase, then right-click and select NewFeature Dataset. Name the 
feature dataset, select the appropriate coordinate system, and set your desired XY tolerance (.0005). 

 



 
 

Double-click on the feature dataset you created. Right-click and select NewFeature Class. Name your 
feature class and alias. Make certain that “Polygon feature” is selected under Type. Click “Next.” You can 
add fields if you like; for example, “Acres.” 

 

From your Editing Toolbar, select EditorStart Editing. Select the Personal Geodatabase that you have 
created as the folder or database you want to edit data from. 

 

 



 
 

Create a boundary around your EMI survey that you think represents your area of interest.  

 

 

Open ArcToolbox, and navigate to Spatial Analysts ToolsExtraction. Double-click on “Extract by 
Mask.” 

 



 
 

In the “Extract by Mask” dialog box, select the appropriate Input raster (Kriging_blac1), Input raster or 
feature mask data (boundary), and Output raster (name and location of new raster). 

 

The new raster output will look like the screenshot below. You will now need to symbolize the raster to fit 
your needs. 

 



 
 

Right-click on the new raster, and select “Properties.” To modify the display range of the dataset, select 
“Classified” under the “Symbology” tab and select the number of classes and the color ramp that you 
want to use to display your data. 

 

 

Below is an example of an interpretive map with a “slope” color ramp with six classes.  

 



 
 

  



 
 

Using the EM38 with Alegro  
 

  



 
 

Using the EM38 with the Archer or Alegro CX data logging devices 
1. EM38 set up 

• Connect cable from EM38 Meter to Archer or Alegro field PC using nine pin receptacles on 
unit. 

2. Power on the unit 
• Tap the start icon 
• Locate and tap the EM38wm icon 

3. This brings up the menu for monitoring and setup 
a. Go to monitor log and tap icon 

• The display will tell you if you are collecting data or not 
b. Survey setup 

• EM38 mode: set to auto 
• Readings/s: set to 5 
• Component: set to conductivity 
• Dipole mode: set to vertical 
• Survey line: set to 0 
• Line increment: set to1  
• Sequence: set to Alternate 
• Direction: Whatever you choose 
• Start station: set to 0 
• Stn Increment: set to 1 
• Tap ok 

c. Tap logger set up 
• EM38 port: set to COM 1 
• Units: set to Feet or Meters 
• Audio: set to yes 
• Pause key: set to any key 
• Tap ok 

d. Tap on Set GPS Port 
• GPS input: Set to enabled 
• Serial port: set to Com 2 
• Baud Rate:  set to 9600 
• Parity: set to No 
• Data bits: set to 8 
• Stop bits: set to 1 
• Tap ok 

e. Tap on Display options 
• In this window you can choose color and thickness of lines,  
• Set display of gridlines for conductivity or in-phase scale 
• Tap ok when done 

f. Tap on view files 
• This window gives you a look at the current files saved 
• Tap ok 

g. Tap on Exit 



 
 

 

Using the  EM38 with the Trimble Yuma 

Checklist and Notes for Use 
 

 
Necessary Devices 
 EM-38-DD or EM38 with Digital Output or Real Time Digital Conversion via 10- 

pin circular connector to 9-pin (RS-232) serial 
 Trimble Yuma 

 

 
Possible Additional Devices 
 For improved portability, Trimble case w/ Neckstrap Accessory and/or sled for 

pulling the EM meter. 
 

 
Necessary Software 
 EM-38XP software from Geonics for data logging (Non-CCE) 
 DAT-38W from Geonics for data analysis and conversion (Non-CCE) 

 

 
Settings 
 In “Virtual-GPS, Settings, Virtual COM. Settings” select COM5, Free and then 

click on the Add button. 
 

 

 
 

 
 
 
 
 



 
 

 
 
 
 
 Turn on the EM meter and plug it in to the serial port on the Yuma. Once Virtual- 

GPS and the EM meter are both running start the EM-38XP program. This order is 
necessary to prevent the EM-38XP program from dropping connections to the 
GPS and EM. If this does occur prior to starting your survey, simply close out of 
EM-38XP and re-open it. The program will retain your settings. 

 
 In EM-38XP - System Setup, assign appropriate Serial Ports for EM-38 & GPS. 

 
o Fargo SSO uses com port 1 for EM-38 and port 5 for the GPS. The GPS 

port must agree with the port you specified in the Virtual GPS application. 
 

 

 



 
 

 In EM-38-XP GPS Port Setup, Assign settings to match the NMEA output of your 
device. Baud rate for Trimble Yuma is 9600. 

 

 

 
 

 
 Summary of Set-up information (survey parameters may vary depending on use 

and may be adjusted by clicking on the Survey Setup button.) To start your survey 
click on the Logging button. 

 

 

 



 
 

 Click on the Data File button to specify a name and location for the file that will 
store the EM data. Notice that the EM meter is transmitting data (a reading of - 
18.5 appears under the Conductivity heading). 

 

 

 
 
 
 
 Click on Go (log data) to begin logging EM data. The Go button will convert to a 

Pause button when you are logging. Click this button and then exit to stop logging 
at the end of the survey.* 

 

 



 

Creating a Grid and Map in Surfer 8 
 
To create a map of the EM response in Surfer 8, you must first create a ‘Grid’ of the data. 
Launch the Surfer 8 program from the Laptop desktop. 

Create Grid: 
Select Grid → Data… 
 In the Open data dialogue box navigate to the xls file of interest and click open. 
In the Grid Data options menu: select appropriate columns etc: 
 X [default to X or Longitude] 
 Y [default to Y or Latitude] 
 Z [select variable of interest HCP or PRP] 
 Gridding Method [Kriging or Natural or Nearest Neighbor] your choice. 
 OK to transform data. 
 
View the Grid Data Report which includes statistical info about the data. Not necessary to save the .report 
but may be useful in some instances. 
 

 Create Map: 
(Generally create a contour map and a post or track overlay map) 
Select: Map → Contour → New Contour Map → 
 In ‘Open Grid’ selection box navigate to grid file just created, then open. 
 
An unenhanced contour map is displayed. 
Select and double-click ‘Contour’ in the Table of Contents on the left. 
In the pop-up Map: Contours Properties dialogue box, set properties: 
 General Tab: Filled Contours, √ Fill contours 



 

   Smooth Contours, √ Medium 
 
 Levels Tab: Fill column → Foreground to adjust color ramp 
   1st select left node then color (usually white to start) 
   2nd select right node then color (eg. Red to show increase) 
   To insert another node, eg. a zero node:  
   Hit control and left click to place the node. OK. 
 
   Labels column →Affected Levels 
   Allows you to label contour lines and set your preferences. 
   (FYI- unit of measure on labels is “mS/m”). 
Select OK to finish the contour map. 
To add your track, create a Post Map. 
Select: Map → Post Map → New Post Map → 
 Navigate to the original xls file used to create the grid and contour map. 
  (We will usually use xls files but Surfer can use txt files). 
 
To edit track symbology: 
 Select and double-click ‘Post’ in the Table of Contents on the left. 
In the pop-up Map: Post Properties dialogue box, select the General tab. 
 General Tab: Change the default symbol from a + to a dot. 
   Change the dot size to 0.02 “ or to you preference. 
 

Save the Map Project  
Save the map project in the file folder with related data using the srf file extension. 
 
 



 

Map Enhancement: Cutting Out Unwanted Areas 
 
Left-click in map area and select… 
Map → Digitize … 
 Mouse over to a node box and let lines disappear, then left-click. 
 Then use mouse and left-clicks to digitize a polygon to cut out making sure to line  mouse 
clicking points up with outer edges to insure no slivers remain. 
 At final leg, copy the coordinates of the first node and paste them in as the last  node to close the 
polygon. 
Finally save the file as a .bln file. 
 
Now, go to Map → Base Map … to import the newly created .bln file. 
 DO NOT CHECK “Areas to Curves” box.  Select OK. 
 
If maps are offset, go to: Edit → Select All, then Map → Overlay. 
This adjusts or aligns all map layers.  
To colorize cutout area: 
Double-click ‘Base’ in the Table of Contents on the left. 
 In dialogue box go to Fill → Fill Pattern and select your preference. 
 
 
  



 

Creating a Grid and Map in Surfer 10 
 

Reference the attached Surfer 10 Quick Start Guide for appropriate chapters.  

• Start with Tutorial Lessons 1 through 7. 
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Surfer® Registration Information


Your Surfer serial number is located on the CD cover or in the email 
download instructions, depending on how you purchased Surfer. 


Register your Surfer serial number online at www.GoldenSoftware.com. 
Or, complete the Registration Form.PDF, located in the main directory 
of the installation CD. Return the Registration Form.PDF by mail or fax. 
This information will not be redistributed.


Registration entitles you to free technical support, free minor updates, 
and upgrade pricing on future Surfer releases. The serial number is 
required when you run Surfer the first time, contact technical support, 
or purchase Surfer upgrades. 


For future reference, write your serial number on the line below.
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Quick Start Guide


Introduction to Surfer
Welcome to Surfer, a powerful contouring, gridding, and surface mapping program for 
scientists, engineers, educators, or anyone who needs to generate maps quickly and 
easily.


Surfer is a grid-based mapping program that interpolates irregularly spaced XYZ 
data into a regularly spaced grid. Grids may also be imported from other sources, 
such as the United States Geological Survey (USGS). The grid is used to produce 
different types of maps including contour, vector, image, shaded relief, 3D surface, 
and 3D wireframe maps. Maps can be displayed and enhanced in Surfer, allowing 
you to produce the map that best represents your data. Adding multiple map layers, 
customizing the map display, and annotating maps with text allows you to create 
publication quality maps. 


An extensive suite of gridding methods is available in Surfer. The variety of available 
methods provides different interpretations of your data and allows you to choose 
the most appropriate method for your needs. In addition, data metrics allow you to 
gather information about your gridded data. Surface area, projected planar area, and 
volumetric calculations can be performed quickly in Surfer. Cross sectional profiles can 
also be computed and exported.


The grid files themselves can be edited, combined, filtered, sliced, queried, and 
mathematically transformed. For example, create an isopach map from two grid files. 
An isopach map shows the difference between two surfaces. You will need the original 
surface grid file and the surface grid file after a volume of material was removed. 
Subtract the two surfaces to create an isopach map. The resulting map displays how 
much material has been removed in all areas.


The ScripterTM program, included with Surfer, is useful in creating, editing, and 
running script files that automate Surfer procedures. By writing and running script 
files, simple mundane tasks or complex system integration tasks can be performed 
precisely and repetitively without direct interaction. Surfer also supports ActiveX 
Automation using any compatible client, such as Visual BASIC. These two automation 
capabilities allow Surfer to be used as a data visualization and map generation post-
processor for any scientific modeling system.


New Features of Surfer 10 are summarized:


�� Online at: www.GoldenSoftware.com/products/surfer/surfernew.shtml


�� In the program: click Help | Contents and click on the New Features page in the 
Introduction book 



http://www.goldensoftware.com/products/surfer/surfernew.shtml
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Surfer


Who Uses Surfer?
People from many different disciplines use Surfer. Since 1984, over 100,000 scientists 
and engineers worldwide have discovered Surfer’s power and simplicity. Surfer’s 
outstanding gridding and contouring capabilities have made Surfer the software 
of choice for working with XYZ data. Over the years, Surfer users have included 
hydrologists, engineers, geologists, archeologists, oceanographers, biologists, 
foresters, geophysicists, medical researchers, climatologists, educators, students, and 
more! Anyone wanting to visualize their XYZ data with striking clarity and accuracy will 
benefit from Surfer’s powerful features!


System Requirements
The minimum system requirements for Surfer are:


�� Windows XP SP2 or higher, Vista, 7, or higher


�� 512MB RAM minimum for simple data sets, 1GB RAM recommended


�� At least 100 MB of free hard disk space


�� 1024 x 768 or higher monitor resolution with a minimum 16-bit color depth


Installation Directions
Installing Surfer 10 requires logging onto the computer with an account that has 
Administrator rights. Golden Software does not recommend installing Surfer 10 over 
any previous versions of Surfer. Surfer 10 can co-exist with older versions (i.e. 
Surfer 9) as long as they are installed in different directories, which is the default. For 
detailed installation directions, see the Readme.rtf file.


To install Surfer from a CD:


1.	 Insert the Surfer CD into the CD-ROM drive. The install program automatically 
begins on most computers. If the installation does not begin automatically, double-
click on the Autorun.exe file located on the Surfer CD.


2.	 Choose Install Surfer (32-bit) or Install Surfer (64-bit) to begin the 
installation.


To install Surfer from a download:


1.	 Download Surfer according to the directions you received.


2.	 Double-click on the downloaded file to begin the installation process.
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Updating Surfer
To update Surfer, open the program and click the Help | Check for Update 
command. This will launch the Internet Update program which will check Golden 
Software’s servers for any updates. If there is an update for your version of Surfer 
(i.e. Surfer 10.0 to Surfer 10.1), you will be prompted to download the update.


Uninstalling Surfer
Windows XP: To uninstall Surfer, go to the Control Panel and double-click Add/
Remove Programs. Select Surfer 10 (32-bit) or Surfer 10 (64-bit) from the list of 
installed applications. Click the Remove button to uninstall Surfer 10.


Vista and 7: To uninstall Surfer when using Regular Control Panel Home, click 
Uninstall a program. Select Surfer 10 (32-bit) or Surfer 10 (64-bit) from the list of 
installed applications. Click the Uninstall button to uninstall Surfer 10.


Vista: To uninstall Surfer when using Classic View Control Panel, double-click 
Programs and Features. Select Surfer 10 (32-bit) or Surfer 10 (64-bit) from the 
list of installed applications. Click the Uninstall button to uninstall Surfer 10.


A Note about the Documentation
The Surfer documentation includes this quick start guide and the online help. Use 
the Help | Contents command in the program to access the detailed online help. 
Information about each command and feature of Surfer is included in the online 
help. In the event the information you need cannot be located in the online help, 
other sources of Surfer help include our support forum, knowledge base, FAQs, and 
contacting our technical support engineers. 


If you prefer printed documentation, you may print the online help in part or in full. 
See the Printing the Online Help section on page 45 for more information. 


Various font styles are used throughout the Surfer documentation. Bold text 
indicates menu commands, dialog names, window names, and page names. Italic text 
indicates items within a dialog such as group box names, options, and field names. For 
example, the Save As dialog contains a Save as type drop-down list. Bold and italic 
text occasionally may be used for emphasis.


In addition, menu commands appear as File | Open. This means, “click the File menu 
at the top of the Surfer window and click the Open command on the File menu list.” 
The first word is the menu name, followed by the command within the menu list.
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Three-Minute Tour
We have included several example files so that you can quickly see some of Surfer’s 
capabilities. Only a few example files are discussed here, and these examples do not 
include all of Surfer’s many map types and features. The Object Manager is a good 
source of information as to what is included in each file.


Example Surfer Files
To see example Surfer files:


1.	 Open Surfer.
2.	 Click the File | Open command and click on 


an .SRF file located in the Samples folder. By 
default, the Surfer installation folder is located 
in C:\Program Files\Golden Software\Surfer 10\
Samples. 


CoordinateSystems.srf
The coordinate systems sample file contains a map 
with multiple map layers. The image map layer is 
color filled and in a State Plane coordinate system. 
The two base map layers show land areas and 
rivers and contain polylines and polygons in a UTM 
coordinate system. The target coordinate system, as 
shown by the axes, is in latitude and longitude.  


Transparent.srf
The transparent sample file contains two map 
layers: a contour map layer and a base map layer. 
The contour layer is partially transparent and shows 
a contamination site. The base map layer is an 
aerial photograph that displays the area below the 
contamination. The map layers are overlaid onto the 
same set of axes. 


The CoordinateSystems.srf shows 
a map with multiple layers from 
different coordinate systems.


The Transparent.srf file shows a 
partially transparent contour layer 
overlaid onto an aerial phtograph.
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Using Surfer
The general steps to progress from a XYZ data set to a finished, grid-based map are 
as follows: 


1.	 Create a XYZ data file. This file can be created in a Surfer worksheet window or 
outside of Surfer (using an ASCII text editor or Excel, for example).


2.	 Create a grid .GRD file from the XYZ data file using the Grid | Data command.


3.	 To create a map, click the Map | New command, select a map type, and use the 
grid file from step two. Grid-based maps include contour, image, shaded relief, 
vector, 3D wireframe, and 3D surface maps. 


4.	 Click on the map to display the map properties in the Property Manager where 
you can customize the map to fit your needs. 


5.	 Click the File | Save command to save the project as a Surfer .SRF file which 
contains all of the information needed to recreate the map.


Using Scripter
Tasks can be automated in Surfer using Golden Software’s Scripter program or any 
ActiveX Automation-compatible client, such as Visual BASIC. A script is a text file 
containing a series of instructions for execution when the script is run. Scripter can 
be used to perform almost any task in Surfer. You can do practically everything with 
a script that you can do manually with the mouse or from your keyboard. Scripts are 
useful for automating repetitive tasks and consolidating a sequence of steps. Scripter 
is installed in the same location as Surfer. Refer to the Surfer Automation help book 
in the online help for more information about Scripter. We have included several 
example scripts so that you can quickly see some of Scripter’s capabilities. 


Example Scripter Files
To run a sample script: 


1.	 Open Scripter by navigating to the installation folder, C:\Program Files\Golden 
Software\Surfer 10\Scripter. Double-click on the Scripter.exe application file.


2.	 Click the File | Open command and select a sample script .BAS file in the C:\
Program Files\Golden Software\Surfer 10\Samples\Scripts folder.


3.	 Click the Script | Run command and the script is executed.


4.	 Most sample scripts will open Surfer and display a map in the plot window.
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Surfer User Interface
Surfer contains three document window types: the plot window, worksheet window, 
and grid node editor window. Maps are displayed and created in the plot window. The 
worksheet window displays, edits, transforms, and saves data in a tabular format. The 
grid node editor window displays and edits Z values for the selected grid. The Surfer 
user interface layout consists of the title bar, menu bar, toolbars, tabbed windows, 
Object Manager, Property Manager, and status bar.


 


This is the Surfer window with the Object Manager and Property Manager 
on the left side. The plot window, where the maps are displayed, is tabbed with 
a grid node editor window and a worksheet window. The toolbars and menu are 


displayed at the top and the status bar is displayed at the bottom.
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The following table summarizes the function of each component of the Surfer layout.


Component 
Name


Component Function


Title Bar The title bar lists the program name plus the saved Surfer .SRF 
file name, if any. An asterisk (*) after the file name indicates the 
file has been modified since it was last saved.


Menu Bar The menu bar contains the commands used to run Surfer.


Toolbars The toolbars contain Surfer tool buttons, which are shortcuts to 
menu commands. Move the cursor over each button to display a 
tool tip describing the command. Toolbars can be customized with 
the Tools | Customize command. Toolbars can be docked or 
floating.


Tabbed Windows Multiple plot windows, worksheet windows, and grid windows can 
be displayed as tabs. Click on the tab to display that window.


Object Manager The Object Manager contains a hierarchical list of the objects 
in a Surfer plot window. These objects can be selected, added, 
arranged, edited, and renamed in the Object Manager. The 
Object Manager is initially docked on the left side above the 
Property Manager. Changes made in the Object Manager are 
immediately reflected in the plot window. The Object Manager 
can be dragged and placed at any location on the screen.


Property 
Manager


The Property Manager allows you to edit any of the properties 
of a selected object. Multiple objects can be edited at the same 
time by selecting all of the objects and changing the shared 
properties. Changes made in the Property Manager are 
immediately reflected in the plot window.


Status Bar The status bar displays information about the activity in Surfer. 
The status bar is divided into five sections. The sections display 
basic plot commands and descriptions, the name of the selected 
object, the cursor map coordinates, the cursor page coordinates, 
and the dimensions of the selected object.


The status bar also indicates the progress of a procedure, such 
as gridding. The percent of completion and time remaining will be 
displayed.
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Changing the Window Layout
The windows, toolbars, managers, and menu bar display in a docked view by default; 
however, they can also be displayed as floating windows. The visibility, size, and 
position of each item may also be changed. Refer to the Changing the Windows Layout 
topic in the online help for more information on layout options.


Docking Managers
Surfer has a docking mechanism feature that allows for easy 
docking of managers. Left-click the title bar of a manager and 
drag it to a new location while holding down the left mouse button. 
The docking mechanism displays arrow indicators as you move 
the manager around the screen. When the cursor touches one of 
the docking indicators in the docking mechanism, a blue rectangle 
shows the window docking position. Release the left mouse button to 
allow the manager to be docked in the specified location. 


Customizing Toolbars and Buttons
You may customize Surfer’s toolbars and menus by clicking the Tools | Customize 
command. This is useful to create custom toolbars, rearrange menus, menu 
commands, and toolbar buttons. You can display image, text, or image and text 
depending on your preference. You can also create a new button appearance for a 
command.


Plot Window
A plot window is the area used for creating and modifying grid files and for creating 
all types of maps. When you first start Surfer, you are presented with an empty plot 
window. Multiple plot windows can be open at one time. Tabs can be used to easily 
move between multiple plot windows. If you need to change the display of tabs click 
the Tools | Options command. Select User Interface on the left side of the dialog. 
Set the MDI tab style on the right side. Setting this value to None turns the display of 
tabs off. 


Menu Commands
The menus contain commands that allow you to add, edit, and control the objects on 
the plot window page. See the Introduction help book in the online help for the Plot 
Window Commands help book that detail the various plot window menu commands. 


Toolbars
Toolbars display buttons that represent menu commands for easier access. Use the 
View | Toolbars commands to show or hide a toolbar. A check mark is displayed 


The docking 
mechanism has 


docking indicators.
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next to visible toolbars. Hold the cursor over any button on the toolbar to display the 
function of the button as a screen tip. A more detailed description is displayed in the 
status bar at the bottom of the window.


Status Bar
The status bar is located at the bottom of the window. Use the View | Status Bar 
command to show or hide the status bar. The status bar displays information about the 
current command or activity in Surfer. The status bar is divided into five sections. The 
left section displays information about the selected command or item in the Property 
Manager. The second section shows shows the selected object name. The middle 
section shows the cursor coordinates in map units, if the cursor is placed above a map. 
The fourth section shows the cursor coordinates in page units of inches or centimeters. 
The right section displays the dimensions of the selected object.


Object Manager
The Object Manager contains a hierarchical list of the objects in a Surfer plot 
window. The objects can be selected, arranged, moved, renamed, or deleted in the 
Object Manager. Changes made in the Object Manager are reflected in the plot 
window, and vice versa.


Click the View | Managers | Object Manager command or the  button to show 
or hide the Object Manager. When the button is depressed, the manager is visible. 
When the button is not depressed, the manager is hidden. 


You can increase the plot document space by minimizing the 
Object Manager with the Auto Hide feature. To hide the 


manager, click the  button in the upper right corner of the 
Object Manager. When the manager is hidden, place the 
cursor directly over the tab to display the Object Manager 


again. Click the  button to return the manager to docked 
mode.


Each item in the Object Manager list consists of an icon 
indicating the object type, a text label for the object, and 
a check box. A  indicates that the object is visible. A  
indicates that the object is not visible. Click the check box 
to change the visibility of the item. Invisible objects do not 
appear in the plot window and do not appear on printed 
output. 


The Object Manager 
contains a hierarchical list 


of the objects in the Surfer 
plot window.
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If an object contains sub-objects, a  or  button displays to the left of the object 
name. Click on the  or  button to expand or collapse the list. For example, a map 
object contains a map type, such as a contour, and normally four axes. The Map can 
contain many other objects. To expand the Map tree to see the axes and map layers, 
click on the  button next to Map. To collapse the Map tree, click on the  button next 
to Map. 


Click on the object name to select an object and display its properties in the Property 
Manager. The selection handles in the plot window change to indicate the selected 
item and the status bar displays the name of the selected object. To select multiple 
objects in the Object Manager, hold down the CTRL key and click on each object.  


To edit an object’s text ID, select the object and then click again on the selected item 
(two slow clicks) to edit the text ID associated with an object. You must allow enough 
time between the two clicks so it is not interpreted as a double-click. Enter the new 
name into the box. Alternatively, you can right-click on an object name and select 
Rename Object. Enter an ID in the Rename Object dialog and click OK.


To change the display order of the objects with the mouse, select an object and drag it 
to a new position in the list above or below an object at the same level in the tree. The 
cursor changes to a black arrow if the object can be moved to the cursor location or a 
red circle with a diagonal line if the object cannot be moved to the indicated location. 
For example, a 3D surface map layer cannot be moved to a map that contains a 3D 
wireframe layer but can be moved into a map that only contains a contour map layer. 
In addition to dragging objects in the Object Manager, the order can be changed 
with the Arrange | Order Objects commands.


 


To delete an object, select the object and press the DELETE key. To move a map layer 
from one map to a new map, click on the map layer and choose Map | Break Apart 
Layer.


Property Manager
The Property Manager allows you to edit the properties of an object, such as a 
contour map or axis. The Property Manager contains a list of all properties for the 
selected object. The Property Manager can be left open so that the properties of the 
selected object are always visible.


Features with multiple options appear with a  or  to the left of the name. To expand 
a section, click on the . To collapse the section, click on the . For example, click on 
a contour map to select it. In the Property Manager, click on the General tab. Click 
the  next to Filled Contours and you see two options, Fill contours and Color scale.
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To change a property in the Property Manager, click on the property’s value next to 
the property name. Select a new property from the pop up box, scroll to a new 


number using the  buttons, select a new value using the  , select a new 
value from the drop-down list or palette, or type a property value. For example, a 
polyline has a Line Properties section that contains Style, Color, Opacity, and Width 
properties. Changing the Color requires clicking on the current color and selecting a 
new color from the color palette. Changing the Width requires highlighting the current 
width and typing a new number or scrolling to a new number. Changing the Opacity 
requires highlighting the existing percentage and typing a new number or clicking on 
the slider bar and dragging it to a new value. 


You can modify more than one object 
at a time. Only shared properties 
are editable when multiple objects 
are selected. For example, you 
can left-click on a polyline in the 
Object Manager. Hold the CTRL 
key and click on a polygon. You can 
then change the line properties of 
both objects at the same time. Fill 
properties, which are available if 
only a polygon was selected, are not 
available as the polyline does not 
have fill properties.


Occasionally, some properties are 
dependent on other selections. For 
example, a polygon has Line and Fill 
tabs in the Property Manager. On 
the Fill tab, there is a Pattern Offset 
section, which is only available when 
an image fill type is selected as the 
Pattern.


Objects in the plot window automatically update after you select an item from a 
palette, press ENTER, or click somewhere else in the Property Manager.  


When working with the Property Manager, the up and down ARROW keys move 
up and down in the Property Manager list. The TAB key activates the highlighted 
property. The right arrow key expands collapsed sections, e.g., Filled Contours, and 
the left arrow collapses the section.


The Property Manager is used to change properties 
of the selected object. Each tab controls different 


properties of the object.
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Use the Tools | Options command to change the default settings. Default settings 
for rulers, drawing grid, line, fill, text, symbol, label format, and advanced settings 
that control each map type can be set from the Options dialog. If the Show info 
area in the Property Manager is checked on the Tools | Options | User Interface 
page, a short help statement for each selected command will appear in the Property 
Manager.


Worksheet Window
The worksheet window opens a data file for editing. Data can be altered, transformed, 
sorted, or filtered. In addition, data can be assigned a coordinate system. The 
components of the worksheet window are displayed below.


Component Name Component Function


Column Letters The column letters identify a column of the worksheet.


Row Numbers The row numbers identify a row of the worksheet.


Active Cell The active cell is highlighted with a bold outline. It is the 
cell  that receives data input (numeric values or text strings) 
from the keyboard. Only one cell is active at a time.


Active Cell Location The location of the active cell is indicated with the column 
letter and row number (i.e. B2).


Active Cell Edit Box The box displaying the data or text contained in the active 
cell is shown in the active cell edit box. Data typed into an 
empty cell appears in both the edit box and the active cell.


Worksheet Name The data file name of the worksheet or the worksheet 
number prior to saving is displayed on the tab.


Select Entire 
Worksheet Button


This button selects all cells in the worksheet.


The components of the worksheet window shown 
above are described in the table below.
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Grid Node Editor
The grid node editor opens a grid file for editing. Nodes display with a black “+”, 
blanked nodes with a blue “x”, and the active node is highlighted with a red diamond. 
To move between nodes, press the ARROW keys, or click a node to make it active. The 
active node XY map coordinates and grid coordinates are displayed at the top of the 
window.  You can enter a new Z value for the node in the edit box. You can save the 
edited grid file with the same name or a different name. 


File Types
Surfer uses four basic file types: data, grid, boundary, and Surfer .SRF files.


Data Files 
Data files are used to produce grid files, post data points on a map, or generate 
a residuals log. These files are generally referred to as XYZ data files or data files 
throughout the help. Data can be read from various file types. Most data files contain 
numeric XY location coordinates and optional Z values. The Z values contain the 
variable to be modeled, such as elevation, concentration, rainfall, or similar types of 
values. 


XYZ data files contain raw data that Surfer interprets to produce a grid file. To create 
a grid file, you must start with a XYZ data file. XYZ data files are organized in column 
and row format. Surfer requires the X, Y, and Z data to be in three separate columns.  


The grid node editor window allows Z values in a grid file to be changed 
or blanked. Individual nodes can be selected and altered. 
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Grid Files 
Grid files produce several different types of grid-based maps, are used to perform 
grid calculations, and to carry out grid operations. Grid files are a regularly spaced 
rectangular array of Z values in columns and rows. Grid files can be created in Surfer 
using the Grid | Data command or can be imported from a wide variety of sources.


Boundary Files 
Boundary files contain XY location data such as state boundaries, rivers, or point 
locations. Boundary files can be used to create layers overlaid on other map types, 
or to specify the boundary limits for blanking, faults, breaklines, or slice calculations. 
Boundary files can be created from a wide variety of vector formats. 


Surfer Files
Surfer .SRF files preserve all the objects and object settings contained in a plot 
window. Maps, grid files, base map files, and data files are all included in the .SRF.


Gridding
A grid is a rectangular region comprised of evenly spaced rows and columns. The 
intersection of a row and column is called a grid node. Rows contain grid nodes with 
the same Y coordinate. Columns contain grid nodes with the same X coordinate.


Contour maps, image maps, shaded relief maps, vector maps, 3D surface maps, and 
3D wireframe maps all require grids in Surfer. The Grid | Data command provides 
several methods for generating a grid file from your XYZ data. Surfer can also use a 
variety of other grid files directly. For a list of these, refer to the online help.


Gridding is the process of taking irregularly spaced XYZ data and generating a Z value 
at each grid node by interpolating or extrapolating the data values. Surfer has several 
different gridding methods. These gridding methods define the way in which the XYZ 
data are interpolated when producing a grid file.


Grid Menu Commands
There are many ways to manipulate grid files in Surfer. The Grid menu contains 
commands used to blank, convert, create, extract, filter, mosaic, slice, smooth, and 
transform grid files. In addition, volume calculations, variogram generation, calculus 
operations, cross section creation, and residual calculations can be performed using 
the commands under the Grid menu. 
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Creating a Grid File
Click the Grid | Data command to change gridding options. With this command, 
specify the parameters for the particular gridding method and the extents of the grid.


Gridding Methods 
Gridding produces a regularly spaced, rectangular array of Z values from irregularly 
spaced XYZ data. The term irregularly spaced means that the points follow no 
particular pattern over the extent of the map, so there are many holes where data are 
missing. Gridding fills in these holes by extrapolating or interpolating Z values at those 
locations where no data exists. The gridding method determines the mathematical 
algorithms used to compute the Z value at each grid node. Each method results in a 
different representation of your data. It is advantageous to test each method with a 
typical data set to determine the gridding method that provides you with the most 
satisfying interpretation of your data. 


Grid Line Geometry
The grid line geometry defines the grid limits and grid density. Grid limits are the 
Minimum and Maximum X and Y coordinates for the grid. Grid density is defined by 
the # of Lines in the X and Y direction of the grid. The grid limits and the number of 
lines define the Spacing, the distance in data units between adjacent grid nodes. The 
intersection of the X line with the Y line is referred to as a grid node.


Surfer automatically computes reasonable values based on the minimum and 
maximum X and Y values of the XYZ data file. The number of nodes is determined by 
the direction that covers the greater extent. By default, the larger distance is assigned 
100 grid lines. The number of grid lines in the other direction is computed so that the 
grid line Spacing in the two directions are approximately the same. Any of the items in 
the Grid Line Geometry section can be altered.


Set the Grid Line Geometry values to control the grid extents 
and grid density by entering the appropriate values. This grid 


will have a different spacing in the X and Y directions.
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Breaklines
Breaklines are used when gridding to show discontinuity in the grid. A breakline is 
a three-dimensional .BLN boundary file that defines a line with X, Y, and Z values at 
each vertex. When the gridding algorithm sees a breakline, it calculates the Z value 
of the nearest point along the breakline, and uses that value in combination with 
nearby data points to calculate the grid node value. Surfer uses linear interpolation 
to determine the values between breakline vertices when gridding. Breaklines are not 
barriers to information flow, and the gridding algorithm can cross the breakline to use 
a point on the other side of the breakline. If a point lies on the breakline, the value of 
the breakline takes precedence over the point. Breakline applications include defining 
streamlines, ridges, and other breaks in the slope. 


The following gridding methods support breaklines: Inverse Distance to a Power, 
Kriging, Minimum Curvature, Nearest Neighbor, Radial Basis Function, Moving 
Average, Data Metrics, and Local Polynomial.


Faults
Faults are used to show discontinuity when gridding, similar to breaklines. A fault is a 
two-dimensional boundary file in .BLN format that defines a line with X and Y values at 
each vertex. Faults do not contain Z values. And, unlike a breakline, faults are barriers 
to information flow. Data on one side of a fault is not used when calculating grid node 
values on the other side of the fault. If the fault line is a closed polygon, the gridding 
algorithm will grid the data on the side of the polygon where the data is located. If the 
fault is not a closed polygon, gridding can search around the end of the fault to see 
a point on the other side of the fault, but this longer distance reduces the weight of 
the point in interpolating the grid node value. If a point lies directly on the fault line, 
random round-off error determines which side of the fault captures the point. 


The following gridding methods support faults: Inverse Distance to a Power, Minimum 
Curvature, Nearest Neighbor, and Data Metrics.


All three maps were gridded with the Minimum Curvature gridding method. The lines on 
the far left image were used as a fault and breakline in the other two images. Note the 


contours stop at the fault line and cross the location where the breakline would be.
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Map Types
Several different map types can be created, modified, and displayed with Surfer. 
These map types include base, contour, post, classed post, image, shaded relief, 
vector, 3D surface, and 3D wireframe maps. A description and example of each map is 
listed below.


Base Map
Base maps display boundaries on a map and can contain 
areas, curves, points, text, images, or metafiles. Base maps 
can be overlaid with other map layers to provide details such 
as roads, buildings, streams, city locations, areas of no data, 
and so on. Base maps can be produced from several file 
formats. Individual base map objects can be edited, moved, 
reshaped, or deleted.


Contour Map
Contour maps are two-dimensional representations of three-
dimensional data. Contours define lines of equal Z values 
across the map extents. The shape of the surface is shown by 
the contour lines. Contour maps can display the contour lines 
and colors or patterns between the contour lines.


Post Map
Post maps and classed post maps show data locations on 
a map. You can customize the symbols and text associated 
with each data location on the map.


Classed Post Map
Classed post maps allow you to specify classes and change 
symbol properties for each class. Classes can be saved and 
loaded for future maps.


Image Map
Image maps are raster images based on grid files. Image 
maps assign colors based on Z values from a grid file. 
Blanked regions on the image map are shown as a separate 
color or as a transparent fill. Pixels can be interpolated to 
create a smooth image.
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Shaded Relief Map
Shaded relief maps are raster images based on grid files. 
Shaded relief maps assign colors based on slope orientation 
relative to a light source. Surfer determines the orientation 
of each grid cell and calculates reflectance of a point light 
source on the grid surface. The light source can be thought of 
as the sun shining on a topographic surface.


Vector Map
Vector maps display direction and magnitude data using 
individually oriented arrows. At any grid node on the map, the 
arrow points in the downhill direction of the steepest descent 
and the arrow length is proportional to the slope magnitude. 
Vector maps can be created using information in one grid file 
(i.e. a numerically computed gradient) or two different grid 
files (i.e. each grid giving a component of the vectors).


3D Surface Map
3D surface maps are color three-dimensional representations 
of a grid file. The colors, lighting, overlays, and mesh can 
be altered on a surface. Multiple 3D surface maps can be 
layered to create a block diagram.


3D Wireframe Map
3D wireframe maps are three-dimensional representations 
of a grid file. Wireframes are created by connecting Z values 
along lines of constant X and Y.
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Map Layers
It is possible to combine several maps to create one map object with multiple layers. 
The Map | Add command allows you to add a map layer to the selected map. Most 
combinations of map types can be combined. You can add any combination of contour, 
base, post, image, shaded relief, vector, or 3D surface maps. You can add any 
combination of contour, base, post, and vector maps with 3D wireframe maps. 


A Map uses a single set of X, Y, and Z axes. Individual map layers are positioned 
according to the map layer’s coordinate system. If two or more map layers have the 
exact same X and Y values, the two layers will occupy the same map space. If two 
layers cover adjacent X and Y areas, the two layers will overlay next to each other in 
the correct relative position. Layered maps become a single Map object and are moved 
and scaled together. The opacity of each map layer can be adjusted individually to 
make a layer transparent or semi-transparent. 


Refer to the Introduction to Map Layers topic in the online help for additional 
information about map layers.


This map has multiple map layers that share axes. The map object controls the 
limits and scale. The individual map layers display the state and county boundaries, 


the county labels, and the image map showing elevation.
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Coordinate Systems
A coordinate system is a method of defining how a file’s point locations display on 
a map. Different types of coordinate systems exist that control how the coordinates 
are shown on the map. In Surfer, a map can be in local coordinates, in a geographic 
latitude and longitude system, or in a known projection and datum.


A local coordinate system is considered unreferenced by Surfer. A local system has 
a location that begins numbering at an arbitrary location and increments numbers 
from this location. This is frequently referred to as a Cartesian coordinate system. 
Most maps are created in local coordinate systems. In these cases, you can ignore the 
options on the Coordinate System tab in the Property Manager, as long as all map 
layers contain the same X and Y coordinates.


A geographic coordinate system uses a spherical surface to define locations on the 
earth. Geographic coordinate systems are commonly called unprojected lat/long.  
Surfer has several predefined geographic coordinate systems available. Each system 
has a different datum. The same latitude and longitude value will plot in different 
locations depending on the datum.


A projected coordinate system consists of a projection and a datum. Each projection 
distorts some portion of the map, based on the ellipsoid and datum specified. 
Coordinates can be lat/long, meters, feet, or other units. Different projections cause 
different types of distortion. 


In Surfer, data, grids, map layers, and maps can have an associated coordinate 
system. All coordinate systems defined by the data, grids, and map layers are 
converted “on the fly” to the map’s target coordinate system. This allows maps with 
different coordinate systems to be easily combined in Surfer.


It is recommended that you do not use projected coordinate systems if you do not 
need to convert between coordinate systems or if all your data are in the same 
coordinate system.


Source Coordinate System - Map Layer
Maps can be created from data, grids, or base map files in any coordinate system. The 
Source Coordinate System is the coordinate system for the data, grid, or base map 
file used to create the map layer. Each map layer can reference a different projection 
and datum. When a map layer has a source coordinate system different than what you 
want the map to display, the map is converted to the map’s Target Coordinate System.  
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3D surface maps and wireframe maps do not have a coordinate system associated 
with them. When a map with a coordinate system is overlaid onto either of these 
map types, the map coordinate system is removed and the maps are displayed in the 
Cartesian coordinates. 


Target Coordinate System - Map
Maps can be displayed in any coordinate system. The map is displayed in the 
coordinate system defined as the Target Coordinate System. A coordinate system 
normally has a defined projection and datum. When a map layer uses a different 
source coordinate system than the map’s target coordinate system, the map layer 
is converted to the map’s Target Coordinate System. The map’s Target Coordinate 
System is the coordinate system in which you want to display your map.


Using Coordinate Systems with Multiple Map Layers
The standard procedure for creating maps in a specific coordinate system are: 


1.	 Create the map by clicking on the appropriate Map | New command. 


2.	 Click on the map layer to select it. In the Property Manager, click on the 
Coordinate System tab.


3.	 If the Coordinate System is not correct, click the Set button next to Coordinate 
System. The Assign Coordinate System dialog opens.


4.	 Make any changes in the dialog. This is the initial coordinate system for the map 
layer. When finished making changes, click OK.


5.	 To change the coordinate system for the entire map, click on the Map object in the 
Object Manager. In the Property Manager, click on the Coordinate System 
tab. 


6.	 If the Coordinate System is not the desired output system, click on the Change 
button next to Coordinate System to set the desired target coordinate system. 
When finished, click OK.


7.	 All of the map layers are converted on-the-fly to the target coordinate system. The 
entire map is now displayed in the desired target system.


Surfer does not require a map projection be defined. Maps can be created from 
unreferenced data, grid, and map layers in local coordinate systems, working in the 
same manner as previous versions of Surfer. As long as all map layers have the 
same X and Y ranges, coordinate systems do not need to be specified. If you do not 
specify a source coordinate system for each map layer, it is highly recommended that 
you do not change the target coordinate system for the map. Changes to the target 
coordinate system for the map can cause the unreferenced map layers to appear 
incorrectly or to not appear.
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Tutorial
The tutorial is designed to introduce basic Surfer features and should take less than 
an hour to complete. After you have completed the tutorial, you will have the skills 
needed to create maps in Surfer using your own data. The tutorial can be accessed in 
the program using the Help | Tutorial command. 


Tutorial Lesson Overview
The following is an overview of lessons included in the tutorial.


�� Lesson 1 - Viewing and Creating Data opens an existing data file and creates a 
new data file.


�� Lesson 2 - Creating a Grid File creates a grid file, the basis for most map types in 
Surfer.


�� Lesson 3 - Creating a Contour Map creates and edits a contour map.


�� Lesson 4 - Modifying an Axis edits the tick labels and axis title.


�� Lesson 5 - Adding a Post Map Layer adds a post map layer, displaying data points 
on the contour map. Both maps share the same axes, limits, and scaling.


�� Lesson 6 - Creating a 3D Surface Map creates and edits a 3D surface map.


�� Lesson 7 - Adding Transparency, Color Scales, and Titles changes the transparency 
of objects, adds a color scale, and add a map title.


�� Lesson 8 - Creating Maps from Different Coordinate Systems loads two map layers 
from different coordinate systems and changes the final target coordinate system.


The lessons should be completed in order; however, they do not need to be completed 
at the same time. Advanced lessons are available in Surfer by clicking Help | 
Tutorial. The advanced lessons are optional, but we encourage you to read through 
them to provide additional detailed knowledge about Surfer’s features.


Starting Surfer
To begin a Surfer session:


1.	 Navigate to the installation folder, which is c:\Program Files\Golden Software\
Surfer 10, by default.


2.	 Double-click on the Surfer.exe application file. 
3.	 A new empty plot window opens in Surfer. This is the work area where you can 


produce grid files, maps, and modify grids. If this is the first time that you have 
opened Surfer, you will be prompted for your serial number. Your serial number is 
located on the CD cover, or in the email download instructions, depending on how 
you purchased Surfer.
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Lesson 1 - Viewing and Creating Data
A data file is a file containing columns of data values. At minimum, three columns 
are required to create grid-based maps in Surfer. These columns contain X, Y, 
and Z values. The X, Y, and Z values are frequently stored in columns A, B, and C, 
respectively, though this is not required. Data files can contain header information, 
labels, point identifiers, filter information, and multiple columns of additional data.


Opening an Existing Data File
To look at an example of an XYZ data file, you can open any sample data file in a 
worksheet window.


1.	 Click the File | Open command, click the  button, or press CTRL+O on the 
keyboard. The Open dialog displays. 


2.	 If you are not in the Samples folder, browse to it. The Samples directory is located 
at C:\Program Files\Golden Software\Surfer 10\Samples, by default. In the list of 
files, click TutorWS.dat.


3.	 Click Open to display the file in the worksheet window.


Notice that the X coordinate 
(Easting) is in column A, the Y 
coordinate (Northing) is in column 
B, and the Z value (Elevation) is 
in column C. Although it is not 
required, row 1 contains header 
text, which is helpful in identifying 
which column contains which data. 
When a header row exists, the 
information in the header row is 
used in the Property Manager 
when selecting worksheet columns.


To edit any value, click in the cell 
to select it. Type information and 
the existing value is overwritten. 
Data can be transformed, sorted, or 
filtered in this window. After making 
changes to the worksheet, save 
the file by clicking the File | Save 
command. The data is displayed in a worksheet window. Note that 


each variable, X, Y, and Z, is in a separate column. 
Row 1 is a description of what the column contains.
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Creating a New Data File
The Surfer worksheet can also be used to create a new data file. Use these steps 
to open a new worksheet window and begin entering data. Refer to the Worksheet 
Window section on page 12 of this guide for information about the various portions of 
the worksheet window.


1.	 Click the File | New | Worksheet command, click the  button, or press 
CTRL+W on the keyboard. A new empty worksheet window is displayed.


2.	 Data are entered into the active cell of the worksheet. The active cell is selected 
by clicking on the cell or by using the arrow keys to move between cells. The 
active cell is indicated by a heavy border and the contents of the active cell are 
displayed in the active cell edit box. The active cell location box shows the location 
of the active cell in the worksheet. Letters are the column labels and numbers are 
the row labels.


3.	 When a cell is active, enter a value or text, and the information is displayed in 
both the active cell and the active cell edit box.


4.	 The BACKSPACE and DELETE keys can be used to edit data as you type. 


5.	 Press the ENTER key and the data are entered into the cell. Press the ESC key to 
cancel without entering the data.


6.	 To preserve the typed data in the active cell, move to a new cell. Move to a new 
cell by clicking a new cell with the mouse, pressing one of the arrow keys, or 
pressing ENTER.


Saving the Data File
When you have completed entering all of the data, the data can be saved in a variety 
of formats.


1.	 Click the File | Save command, click the  button, or press CTRL+S on the 
keyboard. The Save As dialog is displayed if you have not previously saved the 
data file.


2.	 In the Save as type list, choose the DAT Data (*.dat) option.


3.	 Type the name of the file into the File name box.


4.	 Click the Save button and the Data Export Options dialog opens.


5.	 Accept the defaults in the Data Export Options dialog by clicking OK.


6.	 The file is saved in the Data .DAT format with the file name you specified. The 
name of the data file appears in the title bar and on the worksheet tab.
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Lesson 2 - Creating a Grid File
Grid files are required to produce a grid-based map. Grid-based maps include contour 
maps, image maps, shaded relief maps, 1-grid vector maps, 2-grid vector maps, 3D 
wireframes, and 3D surfaces. Grid files are created using the Grid | Data command.  
The Grid | Data command requires data in three columns: one column containing X 
data, one column containing Y data, and one column containing Z data. We will use 
the TutorWS.dat sample file with this lesson.


1.	 If you have the worksheet window open, click on the Window menu and choose 
Plot1, or click on the Plot1 tab. Alternatively, you can create a new plot window 
with the File | New | Plot command. 


2.	 In the plot window, click the Grid | Data command. The Open Data dialog is 
displayed. 


3.	 In the Open Data dialog, click the TutorWS.dat Samples file. You can select 
the file in the file list section or in the Open worksheets section of the dialog by 
clicking once on the file name. The name appears in the File name box below the 
list of data files. Click Open. Alternatively, double-click on the data file name.


4.	 The Grid Data dialog is displayed. The Grid Data dialog allows you to control 
the gridding parameters and preferences. Take a moment to look over the various 
options in the dialog. 


�� The Data Columns section is used to specify the columns containing the X, Y, 
and Z values in the data file. 


�� The Filter Data button is used to filter your data set. 


�� The View Data button is used to see a worksheet preview of your data. 


�� The Statistics button is used to open a statistics report for your data. 


�� The Grid Report option is used to create a report with statistical information 
about the grid file created. 


Click on the Plot1 tab to select the plot window.
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�� The Gridding Method option is used to specify the interpolation gridding 
method. 


�� The Advanced Options button is used to specify advanced settings for the 
selected Gridding Method.


�� The Cross Validate button is used to assess the quality of the gridding method.


�� The Output Grid File displays the path and file name for the grid file.


�� The Grid Line Geometry section is used to specify the XY grid limits, grid  
spacing, and number of grid lines (also referred to as rows and columns) in the 
grid file.


5.	 Click OK. In the status bar at the bottom of the window, a display indicates 
the progress of the gridding procedure. By accepting the defaults, the grid file 
uses the same path and file name as the data file, but the grid file has a .GRD 
extension.


6.	 A Surfer dialog appears after gridding the data with the full path and file name 
of the grid file that was created. Click OK and the grid file is created. 


7.	 If Grid Report was checked, a detailed gridding report is displayed. 


The Grid Data dialog controls the options for gridding a data set. Set the 
Gridding Method, Advanced Options, Grid Line Geometry, and specify a Output 


Grid File name in the dialog before clicking OK. If the Grid Report box is checked, 
a report window will appear with information about the gridding process.
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Lesson 3 - Creating a Contour Map
A contour map is a plot of three values. The first two dimensions are the X and Y 
coordinates. Changing the X and Y coordinates changes the size or limits of the map. 
The third dimension is the Z value, represented by lines of equal value on the map. 
The shape of the surface is shown by the contour lines.


Contour maps are used for a variety of applications. You can contour any Z value 
of data. If you have multiple Z values for your X, Y values, you can create multiple 
contour maps. For example, you could create a contour map for X, Y, Z (elevation) to 
show the topography of your study area. You could then create a contour map for X, 
Y, Z (concentration) to show the concentration values across your study area. The Z 
value could be temperature, concentration, frequency, or any other numeric column of 
data.


The Map | New | Contour Map command creates a contour map based on a grid file. 
This lesson will create a contour map from the .GRD file created in Lesson 2 - Creating 
a Grid File.


1.	 Click the Map | New | Contour Map command, or click the  button in the 
map toolbar.


2.	 The Open Grid dialog is displayed. Select the TutorWS.grd file you created in 
Lesson 2 - Creating a Grid File by clicking once on its name. The file name is 
entered in the File name box. 


3.	 Click Open and the map is created using the default contour map properties.


4.	 If you want the contour map to fill the window, click the View | Fit to Window 


command, click the  button, or press CTRL+D on the keyboard. Alternatively, 
if you have a wheel mouse, roll the wheel forward to zoom in on the contour map. 
Click and hold the wheel button straight down while you move the mouse to pan 
around the screen.
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Changing Contour Levels
After you create a contour map, you can easily modify any of the map features. For 
example, you might want to change the contour levels displayed on the map.


To change the contour levels of the 
map you just created:


1.	 Place the cursor inside the limits 
of the contour map and click 
once. Or, click on the Contours 
object in the Object Manager. 
When the contour layer is 
selected, the contour properties 
are displayed in the Property 
Manager. 


2.	 In the Property Manager, 
click the Levels tab to display 
the contour levels and contour 
line properties for the map. In 
this example, the contour levels 
begin at the Z value = 20. This 
is displayed next to Minimum 
contour. The Maximum contour 
level is Z = 105. 


3.	 To change the contour range, 
click in the box next to Minimum 
contour or Maximum contour. 
Highlight the existing value and 
type a new value. The Data 
range of the grid file is displayed 
at the top of the Levels page, 
making selecting an appropriate 
range easier. For best results, 
select values for Minimum contour 
and Maximum contour that are in or 
near this Data range.


4.	 The Contour interval, or the frequency of contour lines, is five. This means that a 
contour line will be displayed every five Z units. We should see contour lines at 20, 
25, 30, 35, etc. up to 105.


5.	 Click in the Contour interval box, highlight the current value, and type the value 
10. Press ENTER on the keyboard and the map automatically updates to show 
contour lines every 10 Z units.


Set the contour level options on the Levels 
page in the Property Manager.
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Changing Contour Line Properties
You can set any of the options in the list on the Levels page to customize the contour 
map. The Major contour every value allows the setting of two different line styles, 
the major and minor contour lines, for the contour map. The major contour lines 
are frequently referred to as index contour lines. Let’s set two different contour line 
properties.


1.	 Click in the box next to Major contour every. Highlight the existing value and type 
in a new value of 3. Press ENTER on the keyboard and every third line will be an 
index contour. In Surfer, the index contour is a major contour.


2.	 Click on the  next to Major Contours, if it is not already open. Click on the  next 
to Line Properties in the Major Contours section. The major line properties appear. 
Click the black color box next to Color. Select another color, such as Red, from the 
drop-down list. The map automatically updates.


3.	 Click in the box next to Width and change the value to 0.030 inches. Thick red 
lines now appear at the index contours.


4.	 To set the line style for the minor lines, click on the  next to Minor Contours, if it 
is not already open. Click on the   next to Line Properties in the Minor Contours 
section. The minor line properties appear. Click the black color box next to Color. 
Select another color, such as 80% Black, from the drop-down list.


5.	 Click in the box next to Style and select a dashed line from the drop-down list. The 
minor contour lines appear as dashed gray lines.


The major contour lines appear in a heavier solid line.
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Changing Contour Fill Properties
Color fill can be assigned to fill between contour lines by assigning a gradational color 
spectrum between two colors, or by selecting one of the preset color spectrums.


To display contour fill:


1.	 Click on the General tab in the Property Manager. Check the box next to Fill 
contours. The contour map automatically updates to display the default grayscale 
color fill between contours.


2.	 Click on the Levels tab. Click the color bar button next to Fill colors. A drop-down 
list of colormaps appear. Click one of the preset colormaps, such as Rainbow, and 
the map automatically updates to display the new colors.


3.	 If only a minimum and maximum color are desired, click the color bar next to 
Fill contours. Click the Custom button at the bottom of the drop-down list. The 
Colormap dialog appears. 


4.	 The Colormap dialog allows you to select colors to assign to specific Z values. 
Click the color next to Presets. Select GrayScale from the list.


5.	 Click on the left node  below the color spectrum. This selects the minimum color 
node. Click on the button next to Color and select the color Blue in the color drop-
down list. The color scale now ranges from Blue to White. Alternatively, you could 
select a color spectrum from 
the Presets drop-down list, or 
by clicking the Load button.


6.	 (Optional) If you would like 
the color fill to be transparent, 
change the Opacity value 
by clicking and dragging the 
slider next to Opacity. 


7.	 (Optional) If you want the 
color fill to be flipped, with 
White on the left at the 
minimum value and Blue on 
the right at the maximum 
value, click the Reverse 
button. 


8.	 Click OK and the contour map 
is redrawn with the blue to 
white color fill. The contour map is filled with a blue to white colormap 


after adjustments are made in the Colormap dialog.
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Setting Advanced Contour Level Properties
Contour map level properties can be set in the Simple manner, like was shown in 
the previous two sections. Or, you can change more advanced items, such as each  
individual contour line, by using the Advanced method.


To set advanced contour level properties for all levels:


1.	 In the Property Manager, click on the Levels tab.


2.	 Change the Level method by clicking on the word Simple next to Level method and 
selecting Advanced from the drop-down list.


3.	 Click the Edit Levels button next to Contour levels to open the advanced 
Properties dialog.


4.	 Click on the column header buttons to make bulk changes at regular intervals. 
This provides a way to emphasize contours. Click on the Label button. The Labels 
dialog opens.


5.	 Change the First value to 2, the Set value to 1, and the Skip value to 2. This will 
set the label format for the second label, skip the third and fourth labels, and set 
the fifth label with the same format . 


6.	 Click the Font button. The Font Properties dialog opens. Set the Size (points) to 
12. 


7.	 Set the Foreground color and opacity color to white. Click OK.


8.	 Click OK in the Labels dialog. Notice how the label status is changed in the 
Properties dialog.


9.	 Click on the Hach button.  


10.	Set the First to 1, the Set to 1, and the Skip to 0. 


11.	Check the Hachure Closed Contours Only box. 


12.	Change the Direction to Uphill and click OK. This changes all of the items under 
Hach to Yes. All closed contours will have hachure marks.


13.	Click OK and the bulk changes are made to the contour map.


Click on one of the column header buttons to 
make bulk changes.
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To set advanced contour level properties for individual levels:


1.	 Click once on Contours in the Object Manager to select the contour layer.


2.	 In the Property Manager, click on the Levels tab.


3.	 Make sure that the Level method is set to Advanced.


4.	 Click the Edit Levels button next to Contour levels to open the advanced 
Properties dialog.


5.	 In the Properties dialog, you can double-click an individual Z value in the list 
underneath the Level button to change the Z value for that particular contour 
level. Let’s double-click on the number 60. 


6.	 In the Z Level dialog, type in 65. Click OK and the contour line changes to 65.


7.	 You can also double-click the line style for an individual level to modify the line 
properties for the selected level. This provides a way to emphasize individual 
contour levels on the map. Double-click on the line style next to the 70. 


8.	 In the Line Properties dialog, change the Style to a solid line by clicking on the 
existing dashed line and selecting the Solid line from the drop-down list. Click OK.


9.	 Let’s add a single contour line halfway between two existing values. Click on the 
number 65 under the Level column. Click the Add button. The value 57.5 is added 
between the 50 and the 65.


10.	Click OK and the individual settings are made to the contour map.


Double-click the 60 to change the Z value for this contour line.
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Adding, Deleting, and Moving Contour Labels
Contour label locations can be changed on an individual basis. Labels can be added, 
deleted, or moved. To add, delete, and move contour labels:


1.	 Right-click on the contour map and select Edit Contour Labels. You can also edit 
labels of a selected contour map using the Map | Edit Contour Labels command. 
The cursor changes to a black arrowhead   to indicate that you are in edit mode. 
The contour labels have rectangular boxes around them in edit mode.


2.	 To delete a label, click on the label and press the DELETE key on the keyboard. 
For example, left-click on one of the center 65 labels and press the DELETE key on 
your keyboard.


3.	 To add a label, press and hold the CTRL key on the keyboard. The cursor changes 


to  to indicate you are able to add a new label. Left-click the location on the 
contour line where you want the new label to be located.


4.	 Add several contour labels to the solid and dashed red lines by clicking on the line.


5.	 To move a contour label, left-click on the label, hold down the left mouse button, 
and drag the label. Release the left mouse button to complete the label movement.


6.	 To duplicate a label, hold the CTRL key on the keyboard while holding the left 
mouse button on an existing label. Drag the label to a new location along the line.


7.	 To exit the Edit Contour Labels mode, press the ESC key.


Lesson 4 - Modifying an Axis
Every contour map is created with four map axes: the bottom, right, top, and left 
axes. 3D maps have an additional Z axis. Additional X, Y, or Z axes can be added 
to a map with the Map | Add command. You can control the display of each axis 
independently of the other axes on the map. In this example, we will change the axis 
label spacing and add an axis title.  


Adding an Axis Title
To add an axis title to an axis:


1.	 Move the cursor over one of the axis tick labels on the bottom X axis and left-click 
the mouse. In the status bar at the bottom of the plot window, the words “Map: 
Bottom Axis” are displayed. The “Bottom Axis” object is selected in the Object 
Manager. This indicates that you have selected the bottom axis of the contour 
map. Additionally, blue circle handles appear at each end of the axis, and green 
square handles appear surrounding the entire map. This indicates that the axis is a 
“sub-object” of the entire map.


2.	 The bottom axis properties are displayed in the Property Manager. Click on the 
General tab.


3.	 Click the  next to Title to open the Title section if it is not already open. Click 
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in the box next to Title text. Type Bottom Axis and press the ENTER key on the 
keyboard. This places a title on the selected axis.


4.	 If you cannot see the axis title, click the View | Zoom | Selected command. The 
map automatically increases its size to fill the plot window.


Changing the Tick Label Properties
All properties of the axis are editable, including the tick label format and frequency. To 
change the axis tick labels:


1.	 In the Property Manager, click on the Scaling tab to display the axis scaling 
options. In the Major interval box, type the value 1.5 and press ENTER on the 
keyboard to place 1.5 X map units between tick marks. This spacing automatically 
updates on the map axis.


2.	 Click on the General tab and click the  next to Labels, if it is not already open. 
Click the  next to Label Format to open the Label Format section.


3.	 In the Label Format section, select Fixed for the Type. 


4.	 Click in the box next to Decimal digits. Highlight the existing value, type 1, and 
press ENTER on the keyboard. This indicates that only one digit follows the decimal 
point for the axis tick labels.


5.	 The map is updated immediately after every change, showing the axis tick 
spacing, labels, and the axis title.


Change the axis tick mark and label properties or add an 
axis title to display your map exactly the way you want.
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Saving a Map
When you have completed the map in the plot window, you can save the map to a  
Surfer .SRF file. Surfer .SRF files contain all the information necessary to reproduce 
the project. When you save a map as an .SRF file, all the scaling, formatting, and map 
properties are preserved in the file. An asterisk (*) next to the file name in the title 
bar and plot window tab indicates the file has been modified and the modifications 
have not yet been saved.


To save a map:


1.	 Click the File | Save command, or click the  button. The Save As dialog 
is displayed because the map has not been previously saved. Set the Save in  
directory to any directory on your computer.


2.	 In the File name box, type TutorWS.


3.	 Make sure that the Save as type is set to Surfer Files (*.srf). 


4.	 Click Save and the file is saved to the current directory with a .SRF extension. The 
saved map remains open and the title bar changes to reflect the name change. 
There is no longer an asterisk next to the file name.


5.	 If you are using the demo version of Surfer you will not be able to save or export 
the map. Please proceed to Lesson 5 - Adding a Post Map Layer.


Lesson 5 - Adding a Post Map Layer
Post maps are created by placing symbols representing data points at the X, Y data 
point locations on a map. Posting data points on a map can be useful in determining 
the distribution of data points, as well as placing data or text information at specific 
points on the map. Data files contain the X, Y coordinates used to position the points 
on the map. Data files can also contain the labels associated with each point.


Map layers allow you to add multiple maps to an existing map to create one map  
object displaying a variety of map types. The map uses a single set of axes and the 
map layers are positioned according to the target coordinate system. For example, 
if you have a contour map of weather data created, you can add a post map layer 
displaying the location and station names of each data collection station.


When a new post map is created with Map | New | Post Map it is independent of any 
other maps in the current plot window. When the two maps are displayed, two sets 
of axes are also displayed, one set for each map. When you select a map and click 
the Map | Add command, a new map layer, axis, or scale bar can be added to the 
selected map.
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If two maps already existed, a map layer can be dragged to a different map object in 
the Object Manager. Alternatively, select both maps and click the Map | Overlay 
Maps command. All selected map layers are moved to a single map object. 


Adding a Post Map Layer
1.	 Using the TutorWS.srf file you created in the previous lesson, click once on 


Contours in the Object Manager.
2.	 Click the Map | Add | Post Layer command, or right-click on the contour map 


and select Add | Post Layer.
3.	 In the Open Data dialog, select TutorWS.dat from the Samples folder and click 


Open. 


4.	 The post map layer is added to the contour map. Notice in the Object Manager  
that the post map layer has been added to the contour map. The two map layers 
now share the same set of axes. Changes made to the map properties will affect 
both the contour map layer and the post map layer.


Editing the Post Map
Once you have created a post map layer, you can customize the post map properties. 
To change the post map properties:


1.	 Click on the Post in the Object Manager or on the post map in the plot window. 


2.	 In the Property Manager, click on the General tab. Click the  next to Default 
Symbol, if it is not already open. Click the  next to Marker Properties to open the 
Marker Properties section. 


3.	 Next to the Symbol, click on the existing symbol. In the drop-down list, click on 
the filled diamond symbol (Symbol set: Default Symbols, Number: 6) from the 
symbol palette.


4.	 Next to Color, click on the existing color. In the drop-down list, select the Cyan 
color. 


5.	 Opacity can be adjusted to create semi-transparent symbols by dragging the slider 
next to Opacity, if desired.


6.	 In the Symbol Size section, click in the Symbol size box. Highlight the existing size 
and change it to 0.09 in and press ENTER on the keyboard. The post map is drawn 
with the updated symbol size.


If the post map is not visible, ensure that the post layer is on top of the contour layer 
in the Object Manager. The order the layers are listed in a map object is the order 
the map layers are drawn in the plot window. To move a map layer, left-click and drag 
up or down in the map object. Alternatively, select the map layer and use the Arrange 
| Order Objects command or right-click and select Order Objects.
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Selecting and Renaming a Map Layer
After creating a multi-layer map with a post map layer and a contour map layer, you 
can still modify the individual map layers. An individual map layer can be selected in 
the multi-layer map by clicking on the layer in the plot window or clicking on the map 
layer in the Object Manager. The easiest way to select a map layer in a multi-layer  
map is to click on the layer name in the Object Manager.


However, you can also select the layer in the plot window with the mouse. Whenever 
two or more objects occupy the same position in the plot window, use the CTRL key 
and the left mouse button to select the desired object. The CTRL key allows you to 
cycle through the selection of overlapping objects. For example, if you want to select 
a contour map layer behind a post map layer, hold down the CTRL key and click until 
the contour map layer is selected. You can use the status bar to help you to determine 
which object is selected.


To select a map layer and assign or change the object name:


1.	 Click the contour map layer name in the Object Manager. In this case, click the 
word Contours. The status bar should now report Map: Contours.


2.	 Choose Edit | Rename Object or press the F2 key on the keyboard. 


3.	 In the Rename Object dialog, type the name Tutorial Contour Map and click OK. 
The status bar and Object Manager update to reflect the name change.


4.	 Repeat steps 1-3 and rename the post map layer to Tutorial Post Map.


If you click on the Tutorial Contour Map layer in the Object Manager, notice that the 
Property Manager title changes to Property Manager - Map: Tutorial Contour 
Map. When you rename an object in Surfer, the Property Manager window reflects 
the name change making it easier for you to keep track of the object you are editing. 
For example, if you have eight maps in the plot window, it is beneficial to change the 
map names to something meaningful to save time when trying to edit them.


Adding Labels to the Post Map
You can add labels to the data points on post maps and classed post maps.  To add 
labels:


1.	 Click on the Tutorial Post Map layer in the Object Manager.
2.	 In the Property Manager, click on the Labels tab. Next to Worksheet column, 


click the word None. A drop-down list displaying all of columns in TutorWS.dat are 
displayed.


3.	 Select Column C: Elevation from the list.


4.	 Click the  next to Label Format to open the Label Format section.
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5.	 Change the Type to Fixed.


6.	 Change the Decimal digits value to zero and press ENTER on the keyboard.


7.	 The post map layer is automatically redrawn with labels at each of the data points.


Moving Individual Post Map Labels
You can move individual labels of post maps and classed post maps with the Map | 
Edit Post Labels command. Alternatively, right-click the post map and select Edit 
Post Labels to enter edit mode. A customizable leader line is automatically added from 
the data point label to the symbol. To move individual labels:


1.	 Select the Tutorial Post Map in the Object Manager.
2.	 Select the Map | Edit Post Labels command or right-click on the selected map 


and select Edit Post Labels. The cursor will change to a  to indicate you are 
now in post label editing mode.


3.	 Left-click on a label, hold the left mouse button down, and drag the label to a new 
location. With the left mouse button held down, the arrow keyboard keys can be 
used to nudge the label location. Release the left mouse button to place the label 
in the new location. A leader line will be added from the point location to the new 
label location by default. The leader line visibility and line properties are controlled 
on the Labels page in the Property Manager when the post map is selected. 


4.	 Press the ESC key to exit the post label editing mode.


Customize the post map label locations with the 
Map | Edit Post Labels command when the 


post map is selected.
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Lesson 6 - Creating a 3D Surface Map
Surfaces are three-dimensional shaded renderings of a grid file. Surfaces provide an 
impressive visual interpretation of data. Surfaces can be layered with other surfaces, 
so that the surfaces will intersect with each other. Surfaces can also have layers 
of other map types, excluding 3D wireframes. Surfaces allow you to generate an 
elevation model of your area of interest and then add layers of data on the top of the 
surface. You can control the color, lighting, overlay blending, and wire mesh grid of a 
3D surface.


Creating a 3D surface map
We are going to use the same grid file you used to created the tutorial contour map. 
The 3D surface map will provide a new perspective to the contour map you have 
already created. Although we are going to create this map in a new plot window, the 
surface map could easily be added to the existing plot window.


1.	 Click the File | New | Plot command to open a new plot document.


2.	 Select the Map | New | 3D Surface command or click the  button.


3.	 In the Open Grid dialog, select the grid file TutorWS.grd from the list of files. 
The TutorWS.grd, created in Lesson 2 - Creating a Grid File, is located in Surfer’s 
Samples folder.


4.	 Click Open and the 3D surface is created using the default settings.


Adding a Mesh
Mesh lines can be applied to surfaces. 3D surface maps have more capability than 
3D wireframe maps because surfaces can be combined with more map types and 
can change the map limits. Adding mesh lines to a 3D surface map simulates a 3D 
wireframe map. To add a surface mesh:


1.	 Click once on 3D Surface in the Object Manager to select the surface map layer. 
The 3D surface properties are displayed in the Property Manager.


2.	 Click the Mesh tab.


3.	 Check the Draw lines boxes in both the Lines of Constant X and Lines of Constant 
Y sections. The mesh is automatically added to the selected 3D surface.


4.	 In the Lines of Constant X section, change the Frequency to five.


5.	 In the Lines of Constant Y section, change the Frequency to five.
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Changing Surface Map Colors
Changing color schemes on 3D surfaces is similar to changing colors on other map 
types such as image maps or contour maps. You can load previously defined color 
schemes or create your own color schemes. To change the surface material color:


1.	 Click on 3D Surface in the Object Manager to select it. The 3D surface properties 
are displayed in the Property Manager.


2.	 Click on the General tab. Click the  next to Material Color to open the section, 
if it is not already open. Click the color bar next to Upper. In the drop-down 
list, select one of the predefined colormaps, such as Rainbow. The color range 
automatically updates.


3.	 If you wish to define your own colors, click the color bar next to Upper and click 
on the Custom button at the bottom of the drop-down list. The Colormap dialog 
opens.


4.	 In the Colormap dialog, select a predefined colormap from the Presets drop-down 
list. The Presets list contains a variety of predefined color schemes. Alternatively, 
you can click the Load button and select a custom color spectrum .CLR file. The 
ColorScales folder, located in the Surfer installation directory, contains many 
sample .CLR files.


5.	 The Rainbow preset has six nodes that range from purple to red. You can add, 
remove, apply opacity, customize the nodes, or accept the default selections. To 
reverse the color order, click the Reverse button.


6.	 Click OK in the Colormap dialog to update the surface map properties with your 
color changes.


You can continue to experiment with 
the colors by selecting other color 
spectrums from the drop-down list 
next to Upper. Or, click the Custom 
button in the drop-down list and 
make changes in the Colormap 
dialog. You can experiment with 
selecting custom node locations and 
colors.


This is a 3D surface map with a mesh displayed at a 
frequency of five. The 3D surface map is using the 


preset Rainbow color spectrum.
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Adding a Map Layer
You can add additional map layers to the 3D surface with the Map | Add commands. 
When multiple 3D surfaces of differing elevations are added as layers to an existing 
surface map, the surfaces can intersect and overlap each other. If a surface map is 
added to another surface map with the Map | Add | Surface Layer command and 
the two maps are adjacent to each other in the X or Y direction, the surfaces are 
drawn side-by-side. In this example, we will add a planar layer to the surface you just 
created.


1.	 Click on 3D Surface in the Object Manager and select Edit | Rename Object. 
Change the text to TutorWS to make it easier to distinguish the map layer in the 
Object Manager list. Click OK.


2.	 Add a planar 3D surface map layer, by clicking the Map | Add | 3D Surface 
Layer command, or right-click the surface map and select Add | 3D Surface 
Layer.


3.	 In the Open Grid dialog, select the planar grid, TutorPL.grd. Click Open, and the 
new surface map layer is added using the default settings.


4.	 Right-click on the new 3D surface in the Object Manager and select Rename 
Object. Change the text to TutorPL and click OK. This will make it easier to 
distinguish the two map layers in the Object Manager list. 


5.	 Click on the TutorPL surface map in the Object Manager. In the Property 
Manager, click on the General tab. Open the Material Color section and click 
on the color next to Upper. Select Rainbow in the drop-down list to match the 
TutorWS color fill.


Here the two surface map layers are overlaid. 
Depending on the Z values of the grid files, the two 


surfaces can intersect, as this example shows.
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Lesson 7 - Adding Transparency and Color Scales
The opacity of a map, image, text, line, fill, symbol, or entire layer can be customized 
in Surfer. Opacity is the amount that you can see through an object or that light can 
pass through an object. An object can be made semi-transparent by adjusting the 
opacity value. Reducing the opacity of an object allows the ability to see through the 
object to other objects. 0% Opacity means that the object is invisible. 100% Opacity 
means that the object is fully opaque. Setting the opacity is useful when creating a 
semi-transparent map layer. For example, you may want to display a semi-transparent 
contour map layer over a satellite image base map layer so that both map layers can 
be seen. Being able to set the Opacity of entire layers is especially useful when you 
have multiple layers with filled objects and you need to see all of the layers.


Creating a Filled Contour Map
To create a contour map:


1.	 Click the File | New | Plot command. A new empty plot window is displayed.


2.	 Click the Map | New | Contour Map command.


3.	 Select the grid file TutorWS.grd from the list of files in the Open Grid dialog 
and click Open. The map is created using the default settings. The TutorWS.grd, 
created in Lesson 2 - Creating a Grid File, is located in Surfer’s Samples folder.


4.	 Click on the contour map to select it. 


5.	 In the Property Manager, click on the General tab. 


6.	 Check the box next to Fill contours to fill the contours with the default color.


Applying Opacity
You can adjust the Opacity value of a map layer, or of individual fill, text, lines, or 
symbols when the appropriate object is selected. The properties are displayed in the 
Property Manager. To add transparency to a contour map:


1.	 With the contour layer selected, click on the Levels tab in the Property 
Manager.


2.	 Set the Level method to Simple, if it is not already Simple.


3.	 Click the color bar next to Fill colors. Select Rainbow from the drop-down list. The 
Fill colors option changes the colors that are used between the contour lines.


4.	 Click on the Layer tab. 


5.	 Change the Opacity to 43%. The opacity for the entire layer is decreased to 43%.
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Adding and Editing a Color Scale Bar
Color scales are legends that show the fill colors. Color scales are available for contour, 
3D wireframe, 3D surface, image, and vector maps. The color scale displays the colors 
assigned to levels in a filled contour map or 3D wireframe, the colors used in an image 
map or 3D surface, and the fill assigned to vector symbols. To add a color scale to the 
contour map:


1.	 With the contour layer selected, click on the General tab in the Property 
Manager. 


2.	 Check the box next to Color scale. A default color scale is created. A new Color 
Scale object is added to the Object Manager.


3.	 To change the color scale properties, click on the color scale bar to display the 
color scale properties in the Property Manager.


4.	 Make adjustments to the label or line properties. You may wish to change the 
Opacity to 43% to match the contour map. The color scale bar is automatically 
updated with the changed properties.


5.	 To add a title to the color scale bar, click the Draw | Text command. Click to the 
left of the scale bar. The Text Properties dialog opens.


6.	 In the Text section, enter Elevation (Meters), and click OK. Click the ESC key on 
the keyboard to exit the text drawing mode.


7.	 Click on Text in the Object Manager to select the new text object. 


8.	 Click the Arrange | Rotate command. In the Rotate dialog, enter 90 in the 
Counterclockwise rotation in Degrees box. Click OK.


9.	 Click and drag the text box to position it next to the color scale. 


10.	Select the color scale and the text in the Object Manager by selecting the first 
object, holding the CTRL key, and selecting the second object. Once only those two 
objects are selected, use the Arrange | Group command to create a composite 
object. Items in a grouped object can be individually edited, but they are moved 
together. To move the items individually, use the Arrange | Enter Group command.


Adding a Shaded Relief Map Layer
Adding a shaded relief map layer to our existing semi-transparent map will help 
display the elevation behind the contour fill. To add a shaded relief map layer:


1.	 Click on Contours in the Object Manager to select the contour layer.


2.	 Click the Map | Add | Shaded Relief Layer command.


3.	 Select the file TutorWS.grd, and click Open. 


A shaded relief map layer is added to the map object in the Object Manager. Notice 
how the shadows of the shaded relief map layer help distinguish the topography of the 
grid file.
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Lesson 8 - Creating Maps from Different Coordinate Systems
Map layers from different coordinate systems can be created in the same map object. 
Surfer converts the source coordinate system for each map layer to the target 
coordinate system for the entire map. The axes display the target coordinate system. 
To combine multiple layers from different coordinate systems into a single map:


1.	 Click File | New | Plot to open a new plot window.


2.	 Click Map | New | Contour Map to create the first map layer, a new contour 
map. 


3.	 In the Open Grid dialog, click on the Diablo.grd file and click Open.


4.	 Click on Contours in the Object Manager to select the contour layer. 


5.	 In the Property Manager, click on the Coordinate System tab. Note that the 
contour map layer was imported with a coordinate system already specified. This 
map layer is in State Plane 1927 - California III (Meters), as shown in the Name 
field.


6.	 Create a new post map with the Map | New | Post Map command.


7.	 In the Open Data dialog, select the Diablo Example.dat file and click Open.


8.	 Click on the Map that contains the post map and drag it in the plot window so that 
the two maps are side by side. Note that the axes on the two maps have very 
different coordinates. 


9.	 Click on Post in the Object Manager to select the post layer. 


10.	In the Property Manager, click on the Coordinate System tab. Note that the 
post map does not have a predefined coordinate system. 


11.	Click the Set button to define the coordinate system for the post map. Since we 
know this coordinate system, we can set it. Open the Predefined section. Open 
the Projected Systems section. Open the UTM section. Open the North America 
section. Click on the North America NAD27 UTM Zone 10N and click OK. On 
the Coordinate System tab, the post map layer now has a defined coordinate 
system.


12.	In the Object Manager, click and drag the Post map layer into the Map object 
that contains the Contours map layer.


13.	The two map layers are now overlaid. You can see the posted symbols are located 
on the contour lines, despite the different coordinate systems.


14.	To change the target coordinate system, click on the Map object in the Object 
Manager. 


15.	In the Property Manager, click on the Coordinate System tab. Click the Change 
button.


16.	In the dialog, open the Predefined section. Open the Geographic (lat/lon) section. 
Select World Geodetic System 1984 and click OK. On the Coordinate System 
tab, the map now has a different coordinate system than either of the map layers. 
Notice that the axes are now showing latitude and longitude values, as well.
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Printing the Online Help
The online help topics may be printed. You can print a single topic, a section of the 
table of contents, or all topics in the table of contents. 


Printing One Topic
To print one topic:


1.	 Open the topic you wish to print.


2.	 Click the  button. 


3.	 If the Contents page is open in the help navigation pane, you are prompted to 
Print the selected topic or Print the selected heading and all subtopics. Select Print 
the selected topic and click OK.


Printing One Book
To print one book, such as the tutorial: 
1.	 Open the online help by selecting Help | Contents in the Surfer window.


2.	 Click the Contents page on the left side navigation pane.


3.	 Click on the Tutorial book to select the book.


4.	 Click the  button within the help window.


5.	 A prompt appears asking if you would like to Print the selected topic or Print 
the selected heading and all subtopics. Select Print the selected heading and all 
subtopics and click OK. All the topics included in the Tutorial book are printed.


 


Printing the Entire Help File
To print all of the topics in the help file table of contents:


1.	 Open the top-level book in the help book, Surfer 10.


2.	 Click on the Printing the Online Help topic.


3.	 Click the  button within the help window.


4.	 A prompt appears asking if you would like to Print the selected topic or Print 
the selected heading and all subtopics. Select Print the selected heading and all 
subtopics and click OK. All the topics included in the online help table of contents 
are printed. 
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WARNING: Printing the entire help file takes hundreds of letter-sized sheets of paper 
and is very time consuming to print. There is no table of contents or index printed with 
the file.


Getting Help
The quick start guide is a quick way to learn the basics in Surfer. There are also other 
sources of help with Surfer.


Online Help
Extensive information about Surfer is located in the online help. To access the 
online help, choose the Help | Contents command. You can navigate help using the 
Contents, Index, Search, and Favorites pages in the navigation pane to the left of 
the topic page. 


Context-Sensitive Help
Surfer also contains context-sensitive help. Highlight a menu command, window 
region, or dialog, press the F1 key, and help is displayed for the highlighted item. 


You may also access context-sensitive help by pressing SHIFT+F1 or clicking on the 


 button. Then, click on a menu command, toolbar button, or screen region to view 
information specific to that item. The help dialog appears with additional information.


In addition, most dialogs contain a help button. Click the  button in the dialog title 
bar to obtain help for that dialog or click the Help button. 


Internet Resources
There are several Internet help resources. 


�� Direct links to the Golden Software home page (www.GoldenSoftware.com), the 
Surfer product page, the knowledge base, and the Frequently Asked Questions 
are available by selecting Help | Golden Software on the Web.


�� Click the Forums button at the top of the online help (Help | Contents) to post a 
question to our public support forums. 


�� Use the Help | Feedback commands to send a problem report, suggestion, or 
information request by email directly to Surfer technical support. 



http://www.goldensoftware.com

http://www.goldensoftware.com/products/surfer/surfer.shtml

http://www.goldensoftware.com

http://www.goldensoftware.com/faq/surfer-faq.shtml

http://www.goldensoftware.com/activekb/

http://www.goldensoftware.com/forum/

mailto:surfersupport@goldensoftware.com
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Technical Support
Golden Software’s technical support is free to registered users of Golden Software 
products. Our technical support staff is trained to help you find answers to your 
questions quickly and accurately. We are happy to answer all of your questions 
about any of our products, both before and after your purchase. We also welcome 
suggestions for improvements to our software and encourage you to contact us with 
any ideas you may have for adding new features and capabilities to our programs. 


Technical support is available Monday through Friday 8:00 AM to 5:00 PM Mountain 
Time, excluding major United States holidays. We respond to email, phone, and fax 
technical questions within one business day. When contacting us with your question, 
have the following information available:


�� Your Surfer serial number (located on the CD shipping cover or in Help | About 
Surfer) 


�� Your Surfer version number, found in Help | About Surfer, including whether it 
is the 32-bit or 64-bit version of Surfer


�� The operating system you are using (i.e. Windows XP, Vista, or 7), including 
whether it is 32-bit or 64-bit operating system


If you encounter problems with Surfer, you are welcome to send an email message 
to Golden Software using the Help | Feedback | Problem Report command. This 
message is delivered directly to surfersupport@goldensoftware.com. Report the steps 
you perform when the problem occurs and include the full text of any error messages 
that are displayed. You are welcome to attach a .ZIP file (10 MB maximum) containing 
the .SRF file and other files that illustrate the problem. Larger files may be uploaded to 
our FTP site at ftp://ftp.goldensoftware.ws/incoming/Surfer/.


Contact Information
Telephone: 303-279-1021


Fax: 303-279-0909


Email: surfersupport@goldensoftware.com


Web: www.GoldenSoftware.com (includes FAQs, knowledge base, support forum, 
training videos, newsletters, downloads, and more!)


Mail: Golden Software, Inc., 809 14th Street, Golden, Colorado 80401-1866, USA



mailto:surfersupport@goldensoftware.com

ftp://ftp.goldensoftware.ws/incoming/Surfer

mailto:surfersupport@goldensoftware.com

http://www.goldensoftware.com

http://www.goldensoftware.com/faq/surfer-faq.shtml

http://www.goldensoftware.com/activekb/

http://www.goldensoftware.com/forum/

http://www.goldensoftware.com/supportvideo.shtml

http://www.goldensoftware.com/newsletter.shtml

http://www.goldensoftware.com/downloadssummary.shtml
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Customer Service Resources


Before calling, please check the following available resources as your question may 
already be answered.


Business Hours
Technical Support: 


	 Monday through Friday, 8:00 AM - 5:00 PM, Mountain Time


Product Sales: 


	 Online orders available 24 hours, 7 days a week with 2 business hour delivery


Golden Software Contact Information
www.GoldenSoftware.com


surfersupport@goldensoftware.com


phone: 303-279-1021
fax: 303-279-0909


Registration: 
Register online at www.GoldenSoftware.com or fax or mail the Registration 
Form.PDF, located in the main directory on the CD


Knowledge Base: 
www.GoldenSoftware.com/activekb or in the Surfer program using the Help 
| Golden Software on the Web | Knowledge Base command


Forums: 
www.GoldenSoftware.com/forum or in the Surfer program using the
Help | Contents command and click on Forums


Frequently Asked Questions: 
In the Surfer program using the Help | Golden Software on the Web | 
Frequently Asked Questions command


Tutorial: 
Complete the tutorial section in this quick started guide or in the Surfer 
program using the Help | Tutorial command


Online Help: 
In the Surfer program using the Help | Contents command


Support Videos: 
www.GoldenSoftware.com



http://www.goldensoftware.com/faq/surfer-faq.shtml
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